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Registro ANVISA nº: WWWWWWWWWWWWWWWWWWWWWWWWW 
 
Responsável Técnico: Eduardo Ricardo Rodrigues – CREA-SP: 5062083030 
 
 
Conteúdo:  
 
Cirrus HD OCT (Tomógrafo de Coerência Ótica de Alta Definição) Modelo 4000 
 (    ) Cabo força IEC 320 39” 
(    ) Cabo força IEC 329 para NEMA 12” 
(    ) Mini teclado 
(    ) Capa protetora para o equipamento contra poeira 
(    ) Dispositivo de Fixação (Externo) 
(    ) Luva de Oclusão para Dispositivo de Fixação 
(    ) Lâmpada vermelha de fixação 
(    ) Lenços com Álcool 
(    ) Solução de limpeza para lentes de câmera 
(    ) Lenços de limpeza para lentes de câmera 
(    ) Mouse  



 
 

    
 

 

(    ) Ferramenta de Teste de Verificação 
(    ) Chave de Pé (Pedal) 
(    ) Fusível, 5A/ 250V (Para Sistemas 100-120V e 220-240V) 
(    ) Cabo Network CAT5e 
(    ) Cabo USB 
 
1. Identificação do produto 
 

O Cirrus HD OCT permite detalhar o exame em vivo do segmento posterior do olho em uma 
escala espacial extremamente fina, sem biópsia cirúrgica ou sem entrar em contato com o olho. 

Empregando a tecnologia avançada da imagem de tomografia ótica da coerência do 
domínio espectral, a aquisição de dados do HD OCT é 70 vezes mais rápido que um OCT comum e 
com uma melhor resolução. O Cirrus adquire os cubos inteiros de dados OCT de imagem retinal, 
compostos de centenas de linhas escaneadas, quase no mesmo tempo que o Stratus adquire 
aproximadamente seis - linhas escaneadas. Você pode ver estes cubos de dados em três planos, 
ou com três dimensões, dando lhe o acesso a uma quantidade extensiva de dados de imagem 
retinal em uma varredura. 
 
Pretensão de Uso 

O Cirrus HD OCT é pretendido para o uso na visão e na imagem de seção transversal axial 
de estruturas posteriores do olho. 
 
Indicações para Uso 

O Cirrus HD-OCT é um dispositivo tomográfico e biomicroscópico sem-contato, de alta 
resolução da imagem. Indica-se para a visualização in vivo, seção transversal axial, e imagens 
tridimensionais e medidas de estruturas posteriores da ocular, incluindo a retina, da camada de fibra 
do nervo retinal, do macula, e do disco ótico. Pretende-se para o uso como um dispositivo 
diagnóstico para ajudar na detecção e na gerência de doenças oculares incluindo de furos macular, 
do edema da cistóide macular, da diabete retinopática, degeneração macular e glaucoma. 
 
Nota: O Cirrus HD OCT sozinho não indica diagnóstico para doença.   
 
 



 
 

    
 

 

Finalidade deste Manual de Instruções 
O fabricante projetou este manual de instruções para servir com um guia de treinamento, de 

uso e de referência. Nós supomos que os usuários são clínicos ou técnicos com treinamento 
profissional ou experiência no uso de equipamento de imagens oftálmicas, e na interpretação 
diagnóstica das imagens geradas. Quando nós oferecermos treinar no uso do Cirrus HD-OCT, nós 
não oferecemos a instrução na interpretação diagnóstica das imagens geradas. Este manual não 
tem essa função.  
 
Tecnologia do Cirrus HD-OCT 
O Cirrus HD-OCT é um instrumento computadorizado o qual adquire e analisa tomogramas da 
seção transversal e tomogramas tridimensionais do segmento posterior do olho utilizando 
tomografia ótica da coerência do domínio espectral (SD-OCT). SD-OCT é uma forma não invasiva, 
interferometria de baixa coerência para obter imagens com alta resolução da retina sem contatar o 
olho. 
 Na interferometria de baixa-coerência, a luz é emitida ao longo de dois trajetos óticos, um 
que é o trajeto da amostra (no olho) e o outro o trajeto da referência da interferometria.  A fonte de 
luz é de 840 nm, uma luz super luminescente emitida pelo diodo (SLD). O retorno claro da amostra 
e dos trajetos da referência é combinado no detector, que é um espectrômetro no SD-OCT. O 
espectrômetro resolve os sinais de interferência durante toda a profundidade de cada A-Scan 
imediatamente por meio de uma transformação de Fourier. Isto é possível porque o espectrômetro 
resolve as amplitudes relativas e as fases dos componentes espectrais dispersados para trás de 
todas as profundidades de cada A-Scan da amostra do tecido, sem variar o comprimento do trajeto 
da referência. Eliminar a necessidade de mover um braço mecânico de referência faz-se possível 
adquirir dados da imagem OCT aproximadamente 70 vezes mais rápida do que convencional 
(domínio do tempo). O aumento vasto na velocidade da varredura é possível para o Cirrus HD-OCT 
adquirir séries de dados tridimensionais, ou cubos inteiros dos dados no mesmo tempo 
(dependendo do tipo selecionado da varredura) do que um OCT convencional. Apesar da 
velocidade aumentada da varredura, detecção espectral do sinal da interferência fornece uma 
resolução superior. 
 
 



 
 

    
 

 

 Os tomogramas são armazenados no computador e/ou em um arquivo médio, e podem ser 
analisados quantitativamente. Além do sistema de imagem HD-OCT, o Cirrus emprega dois 
sistemas de imagens ao vivo adicionais simultaneamente para facilitar a utilização: uma câmera de 
vídeo do CCD monitora o olho exterior e ajuda-o com alinhamento do escaneamento, quando uma 
linha escaneada do laser oftalmoscópio (LSLO) fornecer uma imagem limpa da área retinal dirigida 
pela varredura. 
 
Informações Gráficas 
 

 
Legenda 
01- Descanso Principal 
02- Abertura da Imagem 
03- Braço de Fixação Externa 
04- Monitor de Vídeo Integrado 
05- Conectores 
06- Controle de altura da mesa 
07- Mouse 
08- Teclado 



 
 

    
 

 

09- Sistema de Chave de Força 
10- Mesa de Força (Opcional) 
11- Unidade de alinhado motorizado 3D de paciente 
12- Descanso de queixo duplo com sensores automáticos Direito/Esquerdo 
 

 
Tela Comum do Software 

 



 
 

    
 

 

 
Passos para desembalar o equipamento 

Nota: Ter especial atenção ao item 4, onde mostra que duas pessoas, e não uma, devem mover o 
equipamento. 

 
 
Especificações Técnicas 
 
Escaneamento no HD-OCT 

• Resolução Axial: 5µm (distância equivalente do tecido) 
• Resolução Transversal: 20 µm (no tecido) 
• Velocidade da scan: 27000 A-scan por segundo. 
• Profundidade do A-Scan: 2,0 mm (no tecido), 1024 pontos. 
• Diodo Super luminescente (SLD) - Comprimento de onda do centro: 840 nm 
• Energia ótica: <725 µW na córnea 

 
Feixe Visual 

• Resolução Transversal: 25 µm (no tecido) 
• Taxa de Repetição: > 20Hz 
• Diodo Super luminescente (SLD) - Comprimento de onda do centro: 750 nm 
• Energia Ótica: <1,5 mW na córnea 

 
Escaneamento da Íris 

• Vista da Íris ao vivo 
 

Fixação Interna 
• Escala do foco de Optometria: -20D a + 20D (dioptrias) 



 
 

    
 

 

 
Fixação Externa 

• Ajuste com diodo emissor de luz  
 
Computador: 

• Processador: Multi-core de alta performance 
• Capacidade de armazenamento: > 80.000 escaneamentos 
• CD-RW e DVD-ROM: Integrado 
• Display: Integrado 15” painel flat de cor. 

 
Dispositivos de Entrada do Sistema 

• Mouse e Teclado 
 

Físico 
• Dimensões (somente instrumento): 65 L x 44 W x 53 H (cm) 
• Peso: 38 Kg  

 
Requerimentos Elétricos 
 
AVISO: Sempre substitua fusíveis pelo mesmo tipo e avaliação. 
 
Cirrus HD OCT 
 
Fase Única, 100-120V ~ sistemas: 50/60 Hz, 5A 
Avaliação do fusível: T 5A 250V 
Fase Única: 220-240V ~ sistemas: 50-60 /hz, 2.5 A 
Avaliação do fusível: T 5A 250V 
 
Iniciar 
Nenhuma precaução inicial necessita ao iniciar o sistema. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

    
 

 

Vista Geral Operacional 
 
Verificação do Sistema no Início 
 

 
 
Durante o início do sistema, o Cirrus HD OCT (Tomógrafo de Coerência Óptica) checa os 
seguintes itens indicados na tela: 
 
Database (Dados base) – checa a acessibilidade e integridade dos dados base.  Se esta 
verificação falhar, você não poderá ir ao início de uma sessão e não usará o instrumento. 
 
Teste do HD (Hard Drive) - verifica a acessibilidade do drive Hard e para adequar o espaço livre 
para adquirir varreduras novas.  Se o espaço livre for criticamente baixo, você pode limpar os 
exames arquivados antes que você adquira varreduras novas. 
 
Arquivo - verifica a acessibilidade da posição atual do arquivo e o espaço livre adequado para 
arquivar varreduras novas.  Você pode continuar sem passar esta verificação, mas o arquivamento 
não pode estar disponível.  Sob os ajustes de padrão, você será alertado a fechar para arquivar os 
exames não arquivados. 
 



 
 

    
 

 

Integridade da Instalação - certifica-se de que os arquivos críticos do software do sistema estão 
presentes e não estão alterados.  Se esta verificação falhar, você não poderá ir ao início de uma 
sessão e usar o instrumento. 
 
Instrumento - verifica a conectividade do hardware do instrumento com o computador do sistema.  
Se esta verificação falhar, você não poderá ir  ao início de uma sessão e usar o instrumento. 
 
Passo Total ou Falha: Abaixo desta lista itens, os relatórios de verificação do sistema total passar 
ou falhar.  Se o sistema passar, avançará automaticamente ao início de uma sessão do usuário.  Se 
falhar, a verificação do sistema remanescerá na tela.  Se isto ocorrer, chame o serviço de cliente da 
Carl Zeiss Meditec: Nos ESTADOS UNIDOS, chamada 800-341-6968.  Fora dos ESTADOS 
UNIDOS, contate seu distribuidor local de CZM.   
 
Início de uma sessão do Usuário 
Você deve realizar o login para acessar as funções do Cirrus HD OCT.  O login do usuário aparece 
automaticamente quando os instrumentos passam a verificar o sistema no início (a cada momento o 
login do usuário sai do software do sistema). 
 

 
 

 
 
Selecione o nome do usuário da lista e entre com a senha correspondente para acessar o sistema 
software 
 

• O nome do usuário não aparece na lista até a lista de clientes serem criadas.  
 
Se você num nome de usuário ou senha inválidos, a mensagem induzirá você a tentar novamente. 
 



 
 

    
 

 

 
 
Quando você realizar o login corretamente, o sistema inicia, a janela de Seleção de Pacientes 
aparece. 
 
Logout – Trava o Sistema 
 
 
Para prevenir o acesso não autorizado, você pode travar o software do Cirrus HD OCT em qualquer 
momento selecionando File > Logout. Quando analisar a modalidade, você pode clicar no botão na 
ferramenta Log Out (mostrado na esquerda). Quando você travar o Cirrus HD OCT, o login do 
usuário é revertido, permitindo o usuário novamente. Realizado o login com sucesso, o sistema 
sempre retorna  a janela de Seleção do Paciente. 
 
Instalação Inicial do Sistema 
 
No início do sistema, um item requer a sua atenção. 
 

1. Crie a lista dos usuários(recomendada). Nós também recomendamos que você crie uma 
senha de proteção para o usuário para prevenir o acesso não autorizado. 
 
Para controlar as funções administrativas, o Cirrus HD OCT dedica a um usuário especial 

com o nome do usuário administrado(admin). Somente o usuário administrado (admin) pode criar e 
editar nome de instituição, lista de clientes e equipes de funcionários. 

  O usuário administrado (admin)  nunca aparece na lista de nomes de usuários na tela do 
login.  Você deve digitar dentro do campo.  O usuário administrado (admin) não aceita senha e nem 
nomes.  O usuário administrado (admin) não pode adquirir ou analisar varreduras. 

 
 
Criando Usuários 
 
Nenhum nome fica disponível para realizar o login até que a lista de usuários seja criada. 



 
 

    
 

 

 
Registrar (Criar) equipe de funcionários 
Para acessar a equipe de funcionários, você deve realizar o login no usuário administrado 

(admin). 
 

1. Clique Options > Staff.... O Registro dos Funcionários aparece. 
2. No Registro dos Funcionários, clique NEW. A caixa de diálogo Novo Funcionário 

aparece. 
 

 
 
 

3. Edite os campos do registro da equipe de funcionários como desejar.O registro da equipe 
tem que ter o sobrenome ou o primeiro nome ou ambos; outros campos são opcionais. Para 
realizar o login com o nome do usuário e adquirir varreduras, a caixa Operator (Operador) 
deve ser selecionada. Quando terminar de preencher os dados, clique Save (Salvar) 

 
NOTA: Se o campo da senha é deixado em branco, o usuário tem que deixar o campo de 
senha em branco para realizar o login. Nome do usuário não é exigido, mas a senha é exigida. 
 



 
 

    
 

 

NOTA: uma vez realizado o login, qualquer usuário pode mudar a senha selecionando Options 
>Change My Password... e preencher a senha mudada. O usuário administrado(admin) pode ter 
vantagens, criando novas listas de usuários com senha temporária fornecida ao usuário, e pede ao 
usuário para mudar a senha. 

 
 

 
Preferências: Arquivo 
 

 
Tela de arquivos de preferência 

 
O Cirrus HD OCT dá-lhe uma maneira para modificar o comportamento padrão para arquivar. 
Selecione Options>Preferences...para acessar o Arquivo Preferencial 

 
A figura acima indica os ajustes padrão.  É possível selecionar um, nenhum ou ambos para iniciar e 
finalizar.  Quando terminado de selecionar suas preferências, clique OK para salvar as alterações e 
para sair, ou clique Cancel para sair sem salvar.  As opções são descritas abaixo. 
 
Recomendação: Mude a senha do administrador 
 
Nós recomendamos que o usuário o quais executam o sistema administrativo mudem a senha do 
administrador, então o sistema tem uma senha especifica para a instituição onde é usado. 
 



 
 

    
 

 

 
Para mudar a senha do administrador, siga os passos abaixo: 

1. Saía do sistema do Visante (clique File > Exit ou clique na direita superior) para 
entrar no sistema operacional. A janela desktpo aparecerá. 

2. Clique Start> Control Panel  e selecione no Painel de Controle User Accounts (Lista dos 
Usuários) 

3. No ”pick an account to change” selecione Administrator (Administrador). 
4. Na próxima tela selecione “Change my password”. (Mudar a senha). Siga os alertas 

indicados na tela para incorporar a sua senha velha, então sua senha nova outra vez a 
confirmar. Opcionalmente, você pode selecionar uma sugestão de senha. Finalmente, 
clique no botão  Change Password (Mudar a senha) 

5.  Quando terminado, a Lista de Usuários e o Painel de Controle são fechados. Com um 
duplo clique o ícone do desktop do Cirrus HD OCT re-iniciar o sistema software. 

 
Criando o Nome da Instituição 
 
Uso o Editar da Instituição para facilitar o suo do sistema. Além disso, o nome da instituição, fornece 
também a opção de adicionar um gráfico do logo no formato bitmap (do bmp). Uma vez que você 
fornece o nome e o login, aparecerá em todas as análises impressas. 
 
Para acessar o Editar (Edit) da Instituição, para você realizar o login como no usuário administrado 
(admin). 
 
 
 
Abaixo os passos para criar o nome da Instituição: 
 

1. Clique Ferramentas > Options > Institutions....A caixa de diálogo Institution Edit (Editar a 
Instituição) aparece. 

 



 
 

    
 

 

 
 
 

2. No campo do nome, digite o nome da sua instituição. O campo requer ao menos um caráter 
e aceita até 64 caracteres, incluindo espaços. O campo nome não pode estar vazio. 

• O logo gráfico é opcional. Se você não está usando o logo gráfico, clique Save 
(Salvar) para salvar as alterações e saía da caixa de diálogo.  

 
 

Seqüência de Operação 
 
O fluxograma abaixo ilustra a seqüência de operação e a relação dos modos de operação: 
 



 
 

    
 

 

 
 
 
A modalidade de Seleção de Paciente é uma modalidade padrão quando você realiza o login do 
Cirrus HD OCT: aquisição de varreduras e análises. Você tem identificar um paciente antes que 
você adquira ou analise dados do exame, e quando você terminar a aquisição da varredura ou 
análise, você retorna a modalidade Seleção de Paciente. Outra janelas e diálogos são regularmente 
usadas, sem cada modalidade, como um subconjunto da função primária (por exemplo: revisão da 
varredura antes de salvar) como um acessório, como a análise da saída da impressora. 
A modalidade da gerência de dados opera-se independentemente e não se tem nenhuma janela 
preliminar;  opera-se nas várias janelas, que você alcança através das opções do menu. As funções 
da gerência de dados críticas para a preservação dos dados, como o arquivo e backup, operam-se 
automaticamente, pelo modo padrão. 
Algumas funções não se enquadram estritamente dentro de algumas das quatro modalidades, por o 
exemplo, facilidade de protocolos de exame.  Estas funções você alcança também através das 
opções do menu. 

 
 
 
 
 
 
 
 



 
 

    
 

 

 
Elementos Comum da Tela 
Esta seção descreve os elementos comuns na tela. 
 
                  Área de Informação do Paciente               Barra de Menu 

 
           Área de Status    Barra de Navegação 
 
 
Área de Informação do Paciente 
Esta área localizada do canto superior esquerdo até a parte central superior contém 
informações básicas do paciente como nome, identificação, sexo e data de aniversário. 
 
Nota: Esta área permanecerá em branco até que seja selecionado um paciente. 
 
Nota: A data de aniversário deve ser inserida no formato MM-DD-YYYY, e sempre aparecerá 
dessa forma no software e impressões. 
 
 
 
 
 



 
 

    
 

 

 
Barra de Menu e Menus 
 
 

Barra Menu e Menus 
 
A barra menu aparece abaixo no título de barra e contem o Records, Edit, Tools e Help 

(Gravações, Editar, Ferramentas e Ajuda).  Clique para selecionar os itens do menu. Anote abaixo 
as características gerais dos menus. 

 

 
Barra de Menus 

 
Disabled menu items (Itens do menu não disponíveis) aparece em cinza. Estes itens são 

estão disponíveis no contexto atual. 
 
Items with “...” following indica os lançamentos do item do menu o qual que fornece umas 

opções mais adicionais antes que o comando seja executado. 
 
A tabela indica e descreve os itens em cada menu, e indica quando cada item está 

habilitado. Anote os atalhos do teclado à direita dos itens do menu aplicável. 

 
Menu Records 

 
 
 
Itens do Menu e Descrições Modalidade Habilitada 
Retrieve Archived Exams: Recupera os 
arquivos de exames. 

Modo ID Patient (Identificação do Paciente) 

Archive Now...: Inicia o arquivamento de todos 
os exames não arquivados.  

Modo ID Patient (Identificação do Paciente) 

Clear Archived Exams: Delete os exames 
arquivados do HD do Cirrus 

Modo ID Patient (Identificação do Paciente) 



 
 

    
 

 

Archive Management...: Abre a caixa de 
diálogo Localização de Arquivos, onde você 
pode criar e gerenciar arquivos. 

Modo ID Patient (Identificação do Paciente) 

Archive Options...: abre a caixa de diálogo 
Preferences (Preferências), onde é possível 
selecionar as preferências do arquivo. 

Modo ID Patient (Identificação do Paciente) 

 

 
Menu Edit 

 
 

Patient Record...: Abre o registro do paciente 
selecionado para editar. 

Modo ID Patient (Identificação do Paciente) com 
um paciente selecionado 

Delete Patient: Deleta o registro do paciente se 
todos os exames são arquivados e limpados do 
disco hard. 

Modo ID Patient (Identificação do Paciente) 

Merge Two Patients...: abre a caixa de diálogo 
Fusão do Paciente, onde você pode selecionar 
2 registros de pacientes  para absorver. 

Modo ID Patient (Identificação do Paciente) 

 

 
Menu Ferramentas 

 
 

 



 
 

    
 

 

Menu de Ajuda 
 
Barra de Navegação 
A barra de navegação, consiste em uma série de botões onde acessa as funções ou outros 
modos operacionais. 
  
ID Patient – Retorna para a tela de identificação do Paciente 
Acquire – Inicia o escaneamento de aquisição. Somente ativo quando um paciente é 
selecionado. 
Analyze – Inicia a análise. Somente ativo quando um paciente com escaneamento salvo é 
selecionado. 
Finish – Sair da atividade atual (escaneamento ou analise) e retorna para a tela anterior. 
Somente ativo quando se está no modo Acquire (Aquisição) e Analyze (Análise). 
 

 
Barra de Navegação 

 
 
Informações da Barra de Status 

 
A barra de status na tela localizado na parte inferior à esquerda, apresenta a informação atual do 
status usando textos e gráficos com sinais de luz. 
 
Indicador do Status do Instrumento 
 
Quando o primeiro sinal de luz a esquerda indica se ou não o instrumento hardware está em 
comunicação com o computador, e conseqüentemente capaz de adquirir varreduras novas. 
 
Verde: a luz verde indica facilidade para adquirir a varredura. 
Vermelha: a luz vermelha indica que você não pode adquirir novas varreduras. A luz vermelha 
indica o mal funcionamento do sistema. 
 
Indicador do Status do disco Hard 
 
O sinal médio indica o espaço disponível no disco Hard. Pode relatar três status: 
 
Verde: mais do que 55 GB espaço disponível no disco hard. 
Amarelo: Entre 15 GB e 55 GB espaço disponível no disco hard. Quando o espaço no disco hard 
está baixo, você tem que reconhecer clicando OK antes de continuar o login na tela. Também, o 
sistema começa automaticamente a limpar os dados dos exames arquivados. 



 
 

    
 

 

Vermelho: Menos do que 15 GB espaço disponível no disco hard. Quando o espaço de disco hard é 
criticamente baixo, a exploração e a análise não são disponíveis. Você deve limpar uma quantidade 
suficiente do espaço do disco hard limpando os  exames arquivados para continuar. Se há exames 
arquivados insuficientes para serem limpos, você deve primeiro arquivar os exames e então limpar 
os mesmos. Você não pode limpar um exame não arquivado. 
 
Indicador do Status do Arquivo 
 

 O círculo vermelho com um X, indica que o arquivo atual local não é acessível. 
 
Verde: mais do que 40 Gb de espaço disponível no local de rede do disco arquivo. 
Amarelo: entre 40 GB e 2GB de espaço disponível no local de rede do disco arquivo. Quando o 
espaço do disco arquivo está baixo, você será induzido a mudar o local do arquivo, mas você pode 
continuar a usar a mesma posição do arquivo que agora. 
Vermelho: menos do que 1 GB de espaço disponível no local de rede do disco arquivo. Quando o 
indicador vermelho aparecer, o software interrompera o arquivamento neste local. Você tem que 
mudar para um novo local de arquivo para reiniciar o arquivamento. 
 
Verificação do Desempenho 
 
Na verificação do desempenho, verifica-se as especificações do desempenho, comparando os 
parâmetros de medidas conhecidas na Ferramenta de Verificação do Exame para as medidas 
transversal e axial feito pela ferramenta scaning. As medidas scaning deve-se enquadrar dentro da 
especificações Carl Zeiss Meditec para a exatidão. Ou scaning será desabilitado até que o sistema 
passe o exame. 
 
Freqüência: Diariamente, no começo de cada dia, você adquira novas varreduras. O software 
suporta isto fornecendo lembretes diários quando necessário. 
 
Tempo Requerido para o Exame: Aproximadamente 2 minutos. 
 
Verificação da Ferramenta Exame: Nós fornecemos esta ferramenta em caso de proteção para 
cada instrumento. Contem peças frágeis que devem ser mantidas em sua posição original para que 
as medidas do exame sejam exatas. Segure-o com cuidado para não derrubar. Os danos à 
ferramenta da verificação do exame podem afetar os resultados do exame. Se você derrubar, nós 
recomendamos que você contate imediatamente o serviço da Carl Zeiss. 



 
 

    
 

 

 
Instalando a ferramenta Teste de Verificação 
Instale a ferramenta Teste de Verificação em correta orientação, com a parte que diz TOP (para 
cima) deve ser deixada para lado de cima. Com seus dedos, vire os parafusos (sentido horário) no 
alto e no fundo para segurar a ferramenta no lugar. Para evitar derrubar a ferramenta, tenha certeza 
que ambos os parafusos estejam fixos antes de soltar a ferramenta. 
 

 
Instalação da Ferramenta Teste de Verificação 

 
Rodar a Verificação 
Para rodar a verificação, siga esses passos: 

1. na tela ID Patient, selecione o paciente chamado TestEye Patient e depois clique Acquire. 
 

Nota: Não é possível editar ou deletar o arquivo TestEye Patient. 
A tela Acquire aparece. 
 



 
 

    
 

 

 
 

2. Se necessário, ajuste o foco no fundo da porta de vista para obter uma imagem limpa do 
teste padrão. A verificação do alinhamento depende da sua habilidade de ver onde a linha 
padrão de escaneamento branco e o amarelo, em relação ao teste padrão. 
Adicionalmente ao foco, outros ajustes usualmente não são necessários, mas é possível 
fazê-los. 

3. Clique Capture. A tela Review Screen (Revisão) aparece automaticamente. 
 



 
 

    
 

 

 
Tela de Revisão de Verificação de Performance 

 
Anotar o teste padrão do tabuleiro de damas e no detalhe o quadrado preto, o menor no centro do 
alvo. A cruz branca central dentro do quadrado central é o alvo do alinhamento. A cruz define a 
escala aceitável de alinhamento entre a imagem LSLO fundus e a imagem do escaneamento OCT, 
como explicado abaixo. 
 
Nota: Quando as linhas branca e amarela estão corretamente centralizadas, pode deve encontrar 
dificuldades para ver a cruz branca central no centro do quadrado, porque as linhas de 
escaneamento são quase tão grossas quanto as linhas brancas que compreendem a cruz central. 
 

4. Com a Transparency (Transparência) selecionada em 0%, use os triângulos para acertar a 
linha de escaneamento horizontal e vertical indicam até o centro do pequeno quadrado. 

 



 
 

    
 

 

 
Indicação dos Triângulos 

 
5. Clique Back (voltar) no lado direito superior para sair do modo full screen (tela cheia). 
6. Agora deslize a Transparency para 100% (transparente). 

 

 
Tela com Transparência de 100 % (tabuleiro de xadrez) 

 



 
 

    
 

 

Condição de Aprovação 
Aprovação – se depois de mudar a transparência para 100 %, ambas as linhas estiverem o mais 
perto possível da cruz central, então o software aprovará o teste. Alguns exemplos de testes 
aprovados. 
 

 
Aprovado 

Linhas centralizadas 
Aprovado - Linha horizontal um 

pouco fora, mas OK. 
Aprovado - Linha vertical um 

pouco fora, mas OK. 
 
Condição de Falha 
Falha – Depois de mudar a transparência para 100 %, se uma das duas linhas estiver no quadrante 
preto, então o teste é considerado falho. Alguns exemplos de testes reprovados. 
 

 
Reprovado 

Linha horizontal no quadrante preto 
Reprovado 

Linha Vertical no quadrante preto 
 

7. Clique em Save (Salvar) para gravar o resultado do teste. Clique Finish para sair do teste 
de performance. 

 
 
 
 
 
 



 
 

    
 

 

Sugestões para Aprovar o Exame 
 
Quando tentar aprovar o exame, tente uma ou mais dos seguintes ajustes, listado na ordem 

recomendada da aplicação. 
1. Verifique e ajuste a instalação da verificação da ferramenta de exame. 
2. Aperte a tecla Try Again (tentar de novo) para refazer o teste. 
3. No caso de diversas falhas repetidas no exame não solucionadas pela sugestão acima, 

saía e reinicie o software e execute novamente o exame. 
 
Desligando o Sistema 
Você pode também finaliza o sistema através do disco hardware ou através do software. 

Em outro caso também, o sistema atravessa uma seqüência para finalizar, o qual impede a perda 
de dados não salvos. 

 
Seqüência para Finalizar o Soft 
Primeiro sugerimos salvar qualquer informação não salva, como varredura ou análise não 

salvada. 
 

Desligando através do Software 
Clique Logout (Sair do Sistema), localizado no canto direito superior. Depois clique em Exit (Sair). 
Uma janela irá se abrir onde perguntara se você tem certeza que quer sair do software. Se sim, 
aperte a tecla YES (Sim). Para incluir o sistema ‘finalizando”, você tem que clicar em Start > Shut 
Down... e então selecione Shut Down, com em qualquer PC. 
 

 
Caixa de Diálogo de Saída 

 
AVISO: Não modifique nem adicione o software  no Cirrus HD OCT exceto se for autorizado por 
Carl Zeiss Meditec. 
 



 
 

    
 

 

Desligando através do Hardware 
Pressione a chave ON/OFF. Depois você sai do sistema software através da seqüência 
“finalizando”do soft, o sistema fechará automaticamente o sistema operacional, e o sistema é 
desligado. 
Você não terá acesso ao sistema operacional do computador. 

 
2. Condições Especiais de Armazenamento, Conservação e/ou Manipulação do produto 
 
Transporte e Armazenamento 
Umidade Relativa: 10% to 100%, condensação incluída 
Temperatura: -40ºC  a +70º C 
Pressão Atmosfera: 500 hPa to 1060 hPa 
 
Operação 
Temperatura: +10 a + 35ºC 
Umidade Relativa: 30% a 75%, excluindo condensação 
Pressão Atmosférica: 700 hPa a 1060 hPa 
 
3. Instruções de uso 
 
Preparando Paciente 
 
Selecione o Método de Fixação 
 
O Cirrus HD OCT estabelece a fixação interna como um método padrão. Este método é preferido 
para a sua reprodutibilidade e facilidade na utilização. Entretanto, se a acuidade visual do paciente 
impossibilita a fixação interna, você tem a opção de unir e de usar um aparelho externo para 
fixação, o qual é emitido por uma luz no final do braço flexível. Conecte na porta do instrumento e 
dobre o braço flexível para posicioná-lo manualmente na posição desejada. 
 
Prepare o Paciente para a Prática do Exame 
 
A prática do exame do paciente com o Cirrus HD OCT é normalmente breve e confortável. Um 
operador experiente pode adquirir várias varreduras de cada olho no espaço de 5-7 minutos. Um 
exame requer geralmente que o paciente olhe dentro da abertura da imagem por 1-3 minutos para 
cada olho, dependendo do número das varreduras desejadas. O equipamento requer mais 
varreduras em menos de 1 segundo. Um tempo adicional é necessário para alinhar o paciente antes 



 
 

    
 

 

de realizar a varredura e para aperfeiçoar a qualidade da varredura. Os pacientes não necessitam 
permanecer no descanso principal durante todo o exame, desde que o operador possa reposicionar 
a cabeça no descanso principal quando necessitar. Note que o Cirrus HD OCT nunca tem contato 
com o olho do paciente. 
 
O que o paciente vê 
 
Durante a exame, o paciente olha dentro da abertura da imagem, e você vê   o inicio de uma fenda 
fixado no alvo contra um fundo preto. Quando uma varredura está sendo executada, o paciente 
pode ver um feixe de varredura como um ponto vermelho de luz que se move através do centro do 
campo da vista. Normalmente, o paciente pode olhar dentro da abertura da imagem por vários 
minutos sem desconforto ou cansaço. 
 
 

 
    Antes do Escaneamento      Durante o escaneamento 
 
Identificando o Paciente 
 
A varredura e a análise não é disponível até você identificar o paciente. Use a janela ID Patient 
(Identificação do Paciente) para identificar (Selecionar ou adicionar) o paciente. Depois do sistema 
ter iniciado e realizado o login a janela ID PATIENT (Identificação do Paciente) aparece como 
padrão. (Nas outra modalidades, selecione File > Find Existing Patient para retornar a janela ID 
PATIENT. Você pode identificar o paciente usando qualquer as 3 opções citadas abaixo: 
 
 
 Find Existing Patient Tab, 
Add New Patient Tab, 
View Today’s Patients Tab, 



 
 

    
 

 

 
Find Existing Patient Tab 
 
No padrão, Find Existing Patient, você pode selecionar o paciente da lista de paciente indicada. 
 
 

 
 
NOTA: A lista está em branco até você buscar. 
 
 
Para povoar a lista do paciente: 
 

1. Clique Search para retornar a todos os pacientes no índice da base de dados. 
2. Para buscar pacientes pelo Nome, ou ID do Paciente, digite no campo correspondente e 

clique Search. Você pode buscar usando informação parcial ou você pode um ou ambos os 
campos. 

• Clique Advanced Search se você quiser buscar usando os parâmetros adicionais. 
 
 
• Quando você busca pelo nome, a busca é aplicada no sobrenonome, no primeiro 

nome, no nome do meio, prefixo e sufixo, e retorna a todos os pacientes estes 
equivalem ao início de qualquer desses campos. 



 
 

    
 

 

• Na lista dos Results (Resultados ), você pode selecionar somente um paciente por 
vez. Quando você selecionar o paciente, o botão SCAN,  torna-se ativo. Se os 
exames do paciente foram salvados, o botão Analyze torna-se ativo. 

 
Add New Patient Tab 
 
Para adicionar o paciente, clique Add New Patient (Adicionar Novo paciente) e preencha os 
campos, como indicado a figura abaixo: 
 

 
 
 

• Se você não quer adicionar mais informações, clique More (Mais) e continue. A caixa de 
registro do paciente aparecerá. 

• Quando você clicar Save (Salvar), a nova informação do paciente é salva na base de dados 
e lista today’s pacients (Pacientes do Dia). Se os dados são perdidos dos campos, você 
deverá completar estes campos antes para você poder salvar. 

 
Quando você clicar Save (Salvar), o Cirrus HD OCT salva a nova informação do paciente e inicia 
um novo exame para cada paciente. 
 



 
 

    
 

 

View Today’s Patients Tab (Vista dos pacientes do dia) 
 
Para selecionar o paciente da lista Today’s Patients (Pacientes do Dia) e selecione View Today’s 
Patients (Vista dos Pacientes do Dia). 
  

 
 
 
 
 
 
Select Scan Type (Selecione o Tipo de Escaneamento) 
 

• Depois de identificar o paciente e clicar Acquire, a janela Acquire aparece. All Scans 
(Todos os escaneamentos) é o protocolo de exame padrão, que contém todos os tipos de 
escaneamentos disponíveis para cada tipo de olho.  

 
 
 
 
 
 
 



 
 

    
 

 

 
Escaneamento de Aquisição 
Quando você seleciona o tipo de escaneamento, a tela de Acquire (Aquisição) aparece. Veja o 
exemplo abaixo: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Alinhe o olho e Adquira a Varredura 
Alinhe o olho para adquirir a varredura.  
 
Quando você selecionar o protocolo do exame na janela precedente, a janela DATA ACQUISITION 
aparece. 
 
O exemplo abaixo mostra Segmento Único Anterior  
 
 



 
 

    
 

 

 
 
 
Alinhar o olho e Adquirir a Varredura 
 
O alinhamento apropriado é requerido em três dimensões, X, Y (Transversal) e Z (axial). O Visante 
fornece controle do alinhamento automáticos usando o mouse, como também controla 
manualmente ambos na tela e pelo teclado. 
Abaixo os passos para alinhar e adquirir a varredura: 
 

1. X-Y- alinhado:  Clique no centro da pupila e reposicione o queixo no suporte de descanso 
para centralizar o ponto. Você pode usar esse método várias vezes com sucesso na 
posição de ajuste fino e espere momentaneamente por cada auto-ajuste para poder 
completar. 

• Se necessário, lembre o paciente para não pressionar muito a cabeça no descanso, assim 
que a testa desliza mais facilmente através do mesmo durante movimentos x-y no descanso 
do queixo.   

• A imagem do vídeo do olho é mais clara, quando na posição axial (alinhamento Z) está 
correto. 

 



 
 

    
 

 

2. Z- alinhamento: Role o mouse para trazer a córnea no campo de visualização na imagem 
da varredura. 

 

 
 
 
Abaixo os passos para alinhar o olho e adquirir a varredura: 

1. Alinhamento X-Y: Clique no centro da pupila e posicione o queixo para centralizar o ponto. 
Você pode usar este método muitas vezes para obter a posição do  ajuste fino, espera 
momentaneamente por cada auto-ajuste para terminar. 

2. Alinhamento Z: Role o mouse para trazer a córnea na vista da imagem da varredura. Role 
para cima ou para frente, para mover o descanso da cabeça e olho para mais perto da 
abertura da imagem. Role o mouse para cima ou para trás para mover o descanso da 
cabeça e o olho para mais distante. 

 
Ajuste Opcional do Ângulo de Fixação: Para varreduras anteriores do segmento, quando a 
imagem da varredura da córnea está visivelmente fora da horizontal, clique no Fixation Angle 
(Ângulo de Fixação) para cima e para baixo, para fazer mais perto da horizontal.  
 
Ajuste Opcional da Polarização: Antes da primeira varredura, você adquire para cada olho, 
você pode desejar ajustar a polarização para otimizar a qualidade da varredura. 
 
3. Adquirir Varredura: Clique direito para adquirir a varredura. Não importa onde o ponteiro está 
quando você clicar.  Este método permite-o adquirir imediatamente uma varredura sem ter que 



 
 

    
 

 

mover o mouse no botão Adquirir (Acquire), que é uma maneira alternativa de adquirir a 
varredura. 
 

Controles Manuais do Descanso do Queixo 
 

Se necessário, você pode usar o botão seta on-screen , para refinar manualmente a posição X, 
Y,Z. Os ajustes ocorrem em passos discretos, quando você clica e solta. Quando você clicar e 
segurar a seta, a movimentação do ajuste se torna contínua até que você solte. 
 
Controle X-Y: Os controles X/Y ajusta o descanso de queixo na direção da seta no setor que 
você clicar: direita, esquerda, para cima ou para baixo (nas direções X e Y). 
 
Controle Z: Os controles X/Y ajusta o descanso de queixo e olho para frente (seta direita) ou 
para trás (seta esquerda) na abertura da imagem. 
 
Processo Automatizado da Varredura 
Quando você adquiriu varredura, inicia se um processo automatizado (os ajustes dos índices 
de refração está incluído). O sistema apresenta a imagem processada (ou ajustes das 
imagens) na tela de revisão. 
 
Ajustes dos índices de Refração – um processo computacional que converte os 
comprimentos do trajeto ótico da distância física pela contabilidade da descontinuidade do 
índice de refração na interface ar/ tecido. Neste processo, o Cirrus HD OCT encontra a 
interface da córnea posterior e anterior. 

Tela de Revisão 
Quando você adquire um escaneamento, a tela de Revisão (Review) aparece. O formato da tela 
de Revisão depende do tipo de escaneamento que foi adquirido. 
 
 
 
 
 
 



 
 

    
 

 

 
Tela Review (Revisão) para Escaneamento por Cubos 

 
 

• Indicador da força do sinal (Signal Strength Indicator): Isto aparece no centro perto do 
alto. Varia de 0-10, com os 10 que são força máxima do sinal. Quando os valores são 
menos de 5, a cor do indicador é vermelha (abaixo do ponto inicial aceitável); quando 5 ou 
mais elevado, a cor se torna verde (aceitável). 

 
Nota: O indicador da força do sinal aplica-se ao escaneamento como um todo. 

 
Tecla Aperte para centralizar (Snap to Center): Clique na tecla Snap to Center para retornar as 

seções da cruz para suas posições da central do defeito. 
 

 
 
 
 
 



 
 

    
 

 

Escaneamento Analyze (Análise) 
Para acessar o Analysis, clique na tecla Analyze (Análise) quando este está ativo; ele está ativo 
quando um paciente gravado com exames salvos é selecionado ou aberto.  
Geralmente irá acessar após ter selecionado um paciente da tela do ID PACIENTE. Quando você 
aperta a tecla da análise (Analyze), a tela da ANÁLISE (Anályze)aparece. Inicialmente mostra 
somente três colunas perto do alto, que alistam: os exames do paciente pela data (coluna 
esquerda), com o exame o mais recente selecionado pelo defeito, e para o exame selecionado, os 
escaneamentos OD (da coluna do centro) e o escaneamento OS (coluna direita) pelo tipo de 
escaneamento. A parcela da exibição da imagem da tela é em branco até que você selecione um 
escaneamento. Clique para selecionar qualquer escaneamento da lista OD ou OS, e as imagens 
correspondentes aparecerão na tela da imagem abaixo, após alguns segundos. 
 
A tela Analyze disponibiliza uma vista anatômica de estruturas descritas nas imagens escaneadas. 
O equipamento disponibiliza dois tipos de análises: 

• Análises interativas avançadas 

• Análises de Imagens de Alta Definição 
 
Analisar a funcionalidade da tela  
As seguintes informações se aplicam a tela Analyze em geral, independente do tipo de 
escaneamento que será visto. 
   Delete Scan Button: Apertar a tecla Delete Scan (Apagar Escaneamento)para 
apagar o arquivo de scan selecionado. Uma caixa de diálogo irá alertar para confirmar sua escolha, 
como abaixo. 

 
   Print button: Clique em Print (Imprimir) para iniciar impressão. Você pode imprimir 
em PDF ou arquivo TIFF ou em papel.  
 
 



 
 

    
 

 

 
Advanced Interactive Analysis (AIA) - Análises interativas avançadas 
 

 
Tela Analyze – Advanced Interactive Analysis 

 
 
 
 
 
 
 
 
 
 
 
 



 
 

    
 

 

High Definition Image Analysis (HDIA) - Análises de Imagens de Alta Definição 

 
Tela Analyze – Análises de Imagens de Alta Definição 

 
Relatórios e Impressão das Imagens AIA e HDIA 
O equipamento tem a possibilidade de gerar relatórios de analises em cor, é possível a impressão 
em papel ou em formato eletrônico. Os formatos eletrônicos aceitos são o PDF e o arquivo TIFF. O 
equipamento disponibiliza dois modos de impressão, o modo de impressão Stock ou Standard e o 
modo de impressão Ad Hoc. Esta sessão irá descrevê-los. 
 
Impressão Stock 
O modo de impressão Stock fornece uma disposição padrão da cópia para escaneamento de cubo 
e para 5 - linha de quadriculação. Para fazer uma impressão Stock, apertar a tecla Print para gerar 
um relatório baseado em o que está atualmente na tela. (as seções atuais aparecerão no relatório.) 
o sistema apresenta uma impressão prévia de cópia do relatório atual da análise e dá-lhe a opção 
para conservá-la eletronicamente no formato TIFF ou formato do PDF, ou para imprimi-la em papel. 
 
 



 
 

    
 

 

 
Impressão Stock do Escaneamento de Cubo 
O impresso Stock para escaneamento de cubo inclui três imagens, uma imagem de fundo e duas 
imagens do escaneamento. A imagem esquerda superior do fundo tem uma folha de prova para 
mostrar a área dirigida pelo escaneamento de cubo e pelas duas fatias atualmente selecionadas. A 
imagem direita superior do escaneamento mostra que o B-Scan lento atualmente selecionado, 
correspondendo à linha de escaneamento (vertical) magenta na folha de prova da imagem de fundo. 
A maior, imagem do escaneamento do fundo mostra que o B-Scan rápido atualmente selecionado, 
correspondendo à linha de escaneamento (horizontal) ciana na folha de prova da imagem de fundo. 
(Este é o sentido de um escaneamento de linha horizontal em OCT de primeira geração) 
 



 
 

    
 

 

 
Impressão Stock do Escaneamento de Cubo 

 
 
 
 



 
 

    
 

 

Impressão Stock 5 Line Raster (5 – Linha de Quadriculação) 
A impressão Stock para 5 Line Raster incluem uma imagem de fundo que mostra a colocação da 
linha de escaneamento e todos os cinco escaneamentos, com o escaneamento maior atualmente 
selecionado. 

 
Impressão Stock 5 Line Raster (5 – Linha de Quadriculação) 



 
 

    
 

 

Impressão Ad Hoc 
A modalidade de impressão Ad Hoc permite gerar um relatório multi-páginas de uma análise 
interativa avançada que mostra tantas imagens de escaneamento e imagens de fundo com folhas 
de prova (do mesmo escaneamento) como você escolher. 

 
Impressão Ad Hoc 



 
 

    
 

 

Gerenciamento de Dados 
O usuário Administrador 
Para gerenciar as funções administrativas, o Cirrus HD-OCT dedica uma conta especial de usuário 
com o nome do usuário admin. Somente o usuário admin pode criar e editar um nome de instituição, 
contas de usuários e registro da equipe de funcionários. 
A conta de administração nunca aparece na lista drop-down de nomes de usuários na tela de login. 
Você deve digitá-lo no campo de digitação. A conta admin aceita qualquer password (senha) ou 
não. O usuário admin não pode adquirir ou analisar escaneamentos. Quando o usuário admin está 
logado, as funções disponíveis no menu são: 

• File (Arquivo) > Log Out (Fechar sessão do usuário) 

• File > Exit (Sair) 

• Options (Opções) > Categories... (Editar Categorias) 

• Options > Institution... (Editar Informações de Instituição) 

• Options > Equipment... (Editar informações do equipamento) 

• Options > Staff...(Registro ou edição de usuários, definir privilégios) 

• Tools (ferramentas) > Event Log...(Registro de Evento) 

• Help (Ajuda) > View License Info... (Ver informações da Licença) 

• Help > About (Ver informações da versão de software) 
Somente o usuário admin pode acessar a caixa de diálogo Institution Edit (editar instituição), a caixa 
de diálogo Equipment Edit (Editar equipamento) e a caixa de diálogo Staff Registration (Registro de 
Usuários). Essas funções administrativas especiais são detalhadas a seguir. 
 
Criar um nome de instituição e Logo 
Usar a caixa de diálogo Institution Edit para customizar seu sistema. Além do nome da instituição, 
dá-lhe também a opção de adicionar um gráfico do logo no formato bitmap (.bmp). Uma vez que 
você forneceu o nome e o logo, aparecerão em todo o impresso da análise.  
Para acessar a caixa de diálogo Institution Edit, você deve ser entrado como o usuário admin. 
Seguir as etapas abaixo para customizar seu sistema: 

1. Clique em Options (opções) > Institution...   A caixa de diálogo Institution Edit irá se abrir. 
 



 
 

    
 

 

 
A caixa de diálogo Institution Edit 

 
2. No campo Name (Nome), escreva o nome de sua instituição. O campo requer pelo menos 

um caráter e aceita até 64 caracteres, incluindo espaços. O campo Name não pode estar 
vazio. 

• Se não for usar um logotipo, clique em Save (Salvar) para salvar suas mudanças e 
sair do diálogo. 

 
Adicionar o gráfico do Logo da instituição (opcional) 
Relembrar que o gráfico deve estar no formato bitmap (extensão de arquivo .bmp após seu nome). 

1. Para adicionar um gráfico do logo, fazer o seguinte para permitir o acesso ao arquivo 
gráfico: 
• Copie o arquivo gráfico do logo do sistema da fonte para um CD e introduza o CD em 

um drive do Cirrus HD-OCT. 
• Importar o arquivo gráfico do logo diretamente de um drive da rede, se o Cirrus HD-

OCT estiver em uma rede. 
2. Clique Browse. Um browser padrão de diretório irá aparecer. O campo Files of Type (Tipos 

de Arquivo) serão limitadas para bitmap, assim você pode ver e selecionar somente 
arquivos com a extensão .bmp. 



 
 

    
 

 

3. Encontrar e selecionar o arquivo gráfico do logo, ou no CD (o drive E:), o disco rígido do 
sistema (C:), ou de um drive da rede. Clique em OK para salvar sua seleção e o retornar à 
caixa de diálogo Intitution Edit. 

• O gráfico selecionado do logo aparecerá no painel Preview. 
4. Clique Save para salvar as mudanças e sair da caixa de diálogo, ou clique Close para sair 

sem salvar. 
 
Informações Gráficas 
 

 
 
 



 
 

    
 

 

4. Advertências e/ou Precauções a serem adotadas 
O Cirrus HD OCT é um equipamento médico. O software e o hardware foram projetados de acordo 
com ESTADOS UNIDOS, europeu e outros padrões médicos internacionais do equipamento, 
projetados para proteção clínicas, de usuários e pacientes e do dano potencial causado por falhas 
mecânicas, diagnósticas ou terapêuticas.  A modificação desautorizada do software ou do hardware 
do Cirrus HD OCT pode prejudicar a segurança dos operadores e dos pacientes, o desempenho do 
instrumento, e a integridade dos dados dos pacientes;  anula também a garantia do instrumento. 
 
Segurança do Produto 
Classe 1 
IPXO –  
Aviso 

 

Não use a impressora ou o instrumento ou a mesa opcional com um cabo de 
extensão ou uma tira de força (tomada portátil múltipla de saída).  Para a segurança 
adicional, não conecte a impressora e o instrumento (ou mesa opcional) na mesma 
tomada de saída.  A falha em deixar de observar este aviso podia resultar em 
choque elétrico ao paciente e/ou ao examinador. 

 

Não abra as tampas do instrumento.  (exceção: Você pode remover a tampa 
traseira para alcançar os fusíveis, as etiquetas e os conectores.) Abrir as tampas do 
instrumento pode expor-se aos perigos elétricos e óticos. 

 

Para manter a segurança ao paciente, os equipamentos periféricos devem ser 
colocados ao menos 1,5 afastado do paciente, tal que o paciente não pode tocar no 
equipamento periférico com qualquer parte do corpo enquanto estiver sendo 
examinado.  Além disso, o operador do instrumento não deve tentar tocar ao 
mesmo tempo no paciente e em um equipamento periférico ao examinar o paciente. 

 

Não reconfigure componentes do sistema na tabela, nem adicione equipamentos ou 
componentes que não são do sistema à mesa, nem substitua componentes originais 
do sistema com os substitutos não aprovados por ZEISS.  Tais ações podem 
resultar em falha no mecanismo de ajuste da altura da mesa, 

 

Este instrumento pode causar a ignição de gases ou de vapores inflamáveis.  Não 
use na presença de anestésicos inflamáveis tais como o óxido nitroso, ou na 
presença do oxigênio puro. 

 



 
 

    
 

 

Compatibilidade Eletromagnética 
EM 60601-1-2:2001 
NOTA: O Cirrus HD-OCT precisa de precauções especiais considerando EMC e precisa ser 
instalado e colocado em serviço de acordo com as informações EMC providenciadas. 
 
NOTA: O equipamento de comunicações portátil e móvel do RF pode afetar o equipamento elétrico 
médico. 

 

 

O uso dos acessórios, dos transdutores e dos 
cabos exceto aqueles especificados podem 
resultar em emissões aumentadas ou diminuído 
do equipamento. 

 

O Cirrus HD OCT não deve ser usado junto ou 
sobre outro equipamento.  Se o uso adjacente 
ou sobre outro equipamento for necessário, o 
equipamento ou o sistema devem ser 
observados para verificar a operação normal na 
configuração em que será usada. 

 
Símbolos e Etiquetas 
 

 

 
Cuidados 

 

Perigo – Presença de choque elétrico 

 

Fusível 

 

Tipo B aplicado 



 
 

    
 

 

 

Fabricante 

 

Representante Autorizado Da Comunidade Européia 

 

Número de série 

 

Número do catálogo/ número da peça 

 

Conformidade Européia 

 

DECLARAÇÃO 
 
  As partes, peças e acessórios descritos a seguir são comercializados somente com 
o equipamento Cirrus HD OCT (Tomógrafo de Coerência Ótica de Alta Definição) Modelo 4000, 
devendo apenas serem utilizados para o fim a que se destinam. 
 
O Cirrus HD OCT (Tomógrafo de Coerência Ótica de Alta Definição) Modelo 4000 é constituído 
de: 
 
(    ) Cabo força IEC 320 39” 
(    ) Cabo força IEC 329 para NEMA 12” 
(    ) Mini teclado 
(    ) Capa protetora para o equipamento contra poeira 
(    ) Dispositivo de Fixação (Externo) 
(    ) Luva de Oclusão para Dispositivo de Fixação 
(    ) Lâmpada vermelha de fixação 
(    ) Lenços com Álcool 
(    ) Solução de limpeza para lentes de câmera 
(    ) Lenços de limpeza para lentes de câmera 
(    ) Mouse  



 
 

    
 

 

(    ) Ferramenta de Teste de Verificação 
(    ) Chave de Pé (Pedal) 
(    ) Fusível, 5A/ 250V (Para Sistemas 100-120V e 220-240V) 
(    ) Cabo Network CAT5e 
(    ) Cabo USB 

 
Responsável Técnico: Eduardo Ricardo Rodrigues – CREA-SP: 5062083030 
 
 
5. Comprovação se o produto encontra-se bem instalado ou conectado aos outros 
produtos para funcionar corretamente e com segurança, bem como a freqüência de 
operações de manutenção e calibração. 
 
Manutenção Preventiva 
 
Os pontos indicados abaixo devem ser considerados quando realizar a Manutenção Preventiva: 
 

• Verifique todos os cabos externos e os cordões de conexão se estão seguros; 

• Verifique-se de que o instrumento está sendo alimentado por uma tomada aterrada da C. A. 

• Observe as condições ambientais na qual o equipamento está operando: 

• As ventoinhas do equipamento estão desobstruídas? 

• Há alguma condição ambiental presente que possa causar geração estática (assoalhos 
atapetados, tempo seco do inverno, etc..) 

• Verifique se os operadores do instrumento tenham quaisquer perguntas/comentários a 
respeito do desempenho do instrumento. 

• Todas as queixas do cliente notáveis durante o PM ou o atendimento técnico devem ser 
documentadas nos detalhes da chamada. 

 
Calibração – Realizada pela Assistência Técnica autorizada. 
 
 
 
 
 
 
 
 
 
 
 



 
 

    
 

 

 
TERMO DE GARANTIA LEGAL 

 
(de acordo com o Código de Proteção e Defesa do Consumidor : Lei 8.078, de 11 de Setembro de 
1990) 
 
A empresa Carl Zeiss do Brasil Ltda, em cumprimento ao Art. 26 da Lei 8.078, de 11 de Setembro 
de 1990 vem por meio deste instrumento legal, garantir o direito do consumidor de reclamar pelos 
vícios aparentes ou de fácil constatação de todos os produtos por ela importados e comercializados, 
pelo prazo de 90 dias, a contar da data de entrega efetiva dos produtos. Tratando-se de vício oculto, 
o prazo decadencial inicia-se no momento em que ficar evidenciado o defeito, conforme disposto no 
Parágrafo 3o do Art.26 da Lei 8.078. 
 
Para que o presente Termo de Garantia Legal surta efeito, o consumidor deverá observar as 
condições abaixo descritas: 
 
Não permitir que pessoas não autorizadas realizem a manutenção dos materiais ou equipamentos 
em questão. 
Não permitir o uso indevido bem como o mau uso dos materiais ou equipamentos em questão. 
Seguir detalhadamente todas as orientações de uso, bem como os cuidados de limpeza e 
conservação descritos no Manual do Usuário ou Instruções de Uso. 
A partes e peças que venham a sofrer desgaste natural pelo uso dos materiais ou equipamentos, 
não estarão cobertas por este Termo Legal de Garantia, se o vício for reclamado após o prazo 
regular determinado pelo fabricante para a substituição desses itens. 
 
6. Informações sobre formas de reutilização do produto, incluindo a limpeza, desinfecção, 
acondicionamento e métodos de esterilização 
 
 
O descanso da testa e do queixo pode ser limpado com um desinfetante tal como o álcool 
isopropílico.  Se espirrar na lente ocular ao limpar o conjunto de montagem principal do paciente, 
limpe delicadamente a lente dianteira com um tecido macio para evitar de manchar. 
 
Aviso - os solventes fortes tais como a acetona ou álcool etílico danificarão o descanso do copo e 
da testa do queixo 
 
Luvas - Os solventes são ásperos à pele, proteção ao desgaste. 
Tecido de Limpeza do Sistema ótico: tecido macio, absorvente, sem fiapos. 
Swabs: cotonetes de algodão e cotonetes de poliéster  
Ventilador: O nitrogênio seco filtrado fundido através de um bocal antiestático é melhor. 
Sabão suave: Sabão neutro, 1% em água. Evite perfumado, alcalóide, ou sabões coloridos. 
Álcool Isopropílico: A classe espectroscópico, evapora mais lentamente do que a acetona. 
Acetona: Grau espectroscópico 



 
 

    
 

 

Hemostático: Para prender a lente macia. 
Tweezers: Para prender óticos pequenos. 
Luz Brilhante: para inspeção 
 
Limpando a Poeira 
 
A poeira no sistema ótico pode ser limitada pela eletricidade estática.  Assoprando pode remover 
alguma sujeira;  o restante pode ser limpado pela tensão de superfície de um cotonete molhado em 
álcool.  A acetona ajuda promover a secagem rápida do sistema ótico para eliminar riscos 
 
Sopre a poeira.  Se alguma poeira permanecer, coloque o papel para lente em torno de um 
cotonete, embeba-o em álcool, e limpe-o o ótico com movimento delicado em oito.  Repita como 
necessário.  Em seguida, repita usando a acetona. 
 
Limpeza de Contaminação 
 
As impressões digitais, o óleo, ou os pontos de água devem ser limpados imediatamente.  Os 
ácidos da pele atacam coatings e os vidros e podem deixar manchas permanentes.  Limpar com 
somente com solventes tende a re- distribuir a sujeira  Estas contaminações devem ser retiradas da 
superfície ótica com sabão ou o outro agente molhado.  O sistema ótico é enxaguado então na água 
e a água remove o álcool.  A acetona ajuda na velocidade de secagem e ajudas a eliminar riscos. 
 
Sopre a poeira. Usando sabão saturado num lenço de papel para lentes em torno de um cotonete, 
limpe o sistema ótico delicadamente em movimentos em oito.  Repita se necessário.  Repita este 
procedimento com água destilada.  Repita outra vez com álcool.  Repita uma vez mais com acetona. 
 
Método de limpeza de gotas e de arraste 
 
Este método é usado freqüentemente para a limpeza leve de superfícies óticas planas, tais como 
espelhos.  Para limpeza de graxas, óleo, pontos de água, ou a outra contaminação pesada, 
começam primeiramente com o procedimento de limpeza mencionado previamente. 
 
Coloque o sistema ótico em uma superfície de trabalho limpa.  Sopre a poeira.  Segure uma parte 
do lenço de papel para lente o qual não está dobrado sobre o sistema ótico e coloque algumas 
gotas de acetona no papel para lente.  Abaixe o papel para lente no sistema ótico e puxe-o através 



 
 

    
 

 

do sistema ótico.  Repita este procedimento até que o ótico esteja limpo.  Esteja certo usar uma 
parte nova do papel para lente a cada limpeza.  Isto evitará riscos na superfície do sistema ótico 
pelo arraste de contaminação. 
 
Método de Limpeza com Escova 
 
Esta técnica é ideal para limpeza de sistemas óticos menores, incluindo lentes, e envolve segurar o 
lenço de papel dobrado para lente com um hemostático para escovar a superfície limpa.   
 
Dobre um papel para lente de modo a não tocar na parte do papel para lente o qual fará o contato 
com o sistema ótico.  A dobra deve ser aproximadamente tão larga quanto o sistema ótica.  Prenda 
o tecido com os hemostáticos paralelos e perto da dobra.  Quando prender o sistema ótico, usando 
pinças se necessário, soprar a poeira.  Embeba o papel para lente em acetona. Esfregue o lenço de 
papel para lente sobre a superfície do sistema ótico, usando pressão leve.   
 
 
Método de Limpeza- Esfregar 
 
Para uma limpeza mais pesada das lentes e dos espelhos, este método envolve limpar o sistema 
ótico com um lenço de papel para lente com as mãos.  Sopre a poeira.  Dobre o lenço de papel para 
lente pelo método da escova.  Aplique a acetona no lenço de papel.  Segurando o lenço de papel 
nas mãos com a dobra perto da ponta de seus dedos, aplique a pressão uniforme ao limpar 
delicadamente através da superfície do sistema ótico.  Repita se necessário até que o sistema ótico 
esteja limpo. 
 
7. Informações sobre tratamentos ou procedimentos adicionais antes da utilização do 
produto 
 
Instalação da Mesa (opcional) 
 
Coloque o instrumento na mesa como a orientação ilustrada abaixo.  O monitor deve estar ao lado 
do interruptor up/down 
 
 



 
 

    
 

 

 
 
 
O cabo de força deve ser passado através do orifício localizado na mesa. 
 
Operando o elevador da mesa 
A chave UP/DOWN está do lado do operador, montado na borda da mesa. Para levantar a mesa, 
pressione seta para cima;  para abaixá-la, pressione a seta para baixo. 
 
 
 

 
 
 
 



 
 

    
 

 

Instalação da Ferramenta de Verificação do Exame 
 
 
Instalar a Ferramenta de Verificação do Exame com a etiqueta voltada para cima como mostra a 

figura abaixo. A  descrito nos ambos lados da ferramenta indica a operação correta. 
 
 
 

 
 
 

 
 
 
 
 



 
 

    
 

 

 

 
 
Os pequenos parafusos no lado de dentro da ferramenta, se encaixam nos 2 orifícios internos na 
posição 9 horas e 3 horas também no lado da abertura da imagem. A ferramenta é prendida no 
posição magnética quando os parafusos são ajustados. Para evitar que a ferramenta caía, 
certifique-se de que ambos pregos estão ajustados antes de liberar a ferramenta. 
 
 

 
 
Parafusos fixados no orifício interno na posição 9 
horas e 3 horas. 

 
A ferramenta é fixada na parte magnética. 
  

 
 
NOTA: É possível instalar a ferramenta de cabeça para baixo. Quando instalado incorretamente, a 
etiqueta estará com a face para baixo e você não verá o exame no vídeo de imagem. Em vez disso, 
a imagem de vídeo ficará em branco. Quando você observar isto, reinstale a ferramenta no lado 



 
 

    
 

 

direito. É também é possível que a ferramenta estará prendida na parte magnética com somente um 
prego ajustado no local. 
 
8. As precauções em caso de alteração do funcionamento do produto 
 
Mensagens de Erro 
 

Erro Descrição 
RX DATA INVALID Recebe as mensagens dos dados inválidos 
COMM OUTAGE Nenhuma mensagem válida recebida por menos 2 

segundos.  Cancelado após 3 mensagens válidas 
recebidas. 

STARTED UP Iniciação dos firmware completas.  Cancelado após 3 
mensagens válidas recebidas. 

LEFT EYE Sensor do olho esquerdo coberto 
RIGHT EYE Sensor do olho direito coberto 
XY OUT OF RANGE O Hardware fora da escala d circuito detectou 

amplitudes do galvo de XY abaixo da escala mínima. 
SUMMARY ERROR Indica a condição de erro em exceção daqueles em 

resumo no status byte. 
BUSY A mensagem não pode ser manipulada no mesmo 

momento 
EYE ERROR Sensor do olho coberto no início. 
FPGA HEAD ERROR Verificação da leitura do registro falhou para cabeça 

ótica PCBA FPGA 
FPGA Z ERROR 
 

Verificação da leitura do registro falhou para a 
varredura Z PCBA FPGA 

RAM Z FAIL 
 

Verifica a varredura Z RAM falhou 

OPTOMETER PHASE A+ ERROR Teste de corrente da fase do  motor do optómetro 
falhou. 

OPTOMETER PHASE A- ERROR Teste de corrente da fase do  motor do optometro 
falhou. 

OPTOMETER PHASE B+ ERROR 
 

Teste de corrente da fase do  motor do optometro 
falhou. 

OPTOMETER PHASE B- ERROR 
 

Teste de corrente da fase do  motor do optometro 
falhou. 

MIRROR PHASE A+ ERROR 
 

Teste de corrente da fase do motor do espelho falhou. 

MIRROR PHASE A- ERROR 
 

Teste de corrente da fase do motor do espelho falhou. 

MIRROR PHASE B+ ERROR 
 

Teste de corrente da fase do motor do espelho falhou. 

MIRROR PHASE B- ERROR 
 

Teste de corrente da fase do motor do espelho falhou. 

P PHASE A+ ERROR Teste de corrente da fase do motor polarizado falhou. 



 
 

    
 

 

 
P PHASE A- ERROR 
 

Teste de corrente da fase do motor polarizado falhou. 

P PHASE B+ ERROR 
 

Teste de corrente da fase do motor polarizado falhou. 

P PHASE B- ERROR 
 

Teste de corrente da fase do motor polarizado falhou. 

Z PHASE A+ ERROR 
 

Teste de corrente da fase do motor falhou. 

Z PHASE A- ERROR 
 

Teste de corrente da fase do motor falhou. 

Z PHASE B+ ERROR 
 

Teste de corrente da fase do motor falhou. 

Z PHASE B- ERROR 
 

Teste de corrente da fase do motor falhou. 

HOME CHIN X ERROR 
 

Suporte Paciente X  Falha do repouso do motor. 

HOME CHIN Y ERROR 
 

Suporte Paciente Y  Falha do repouso do motor 

HOME CHIN Z ERROR 
 

Suporte Paciente Z  Falha do repouso do motor 

HOME OPTOMETER ERROR 
 

Falha do repouso do motor optometro. 

HOME MIRROR ERROR Falha do repouso do motor do espelho. 
HOME P ERROR Falha do repouso do motor polarizado. 
HOME Z ERROR Falha do repouso do motor 
CHIN CONNECT ERROR 
 

O status principal bit FPGA indica a sustentação do 
paciente não está unida ao sistema. 

Z CONNECT ERROR Erro na conexão Z PCBA 
SPI CONNECT ERROR Erro do cabo SPI 
SPI ERROR Ler novamente o exame 0xF falhou. 
Z 5V ERROR 
 

ADC leitura da varredura Z PCBA +5V / +3.3V nível fora 
da escala. 

Z 15V ERROR 
 

ADC leitura da varredura Z PCBA +15V / -15V fora nível 
da escala. 

Z REF PLUS ERROR 
 

ADC leitura da varredura Z PCBA REF + 
 Nível fora da escala. 

Z REF MINUS ERROR 
 

ADC leitura da varredura Z PCBA REF - 
 nível da escala. 

Z TEMP ERROR 
 

ADC leitura da varredura Z PCBA Temp 
 nível fora da escala. 

Z GALVO POWER ERROR Z FPGA status bit. 
Z GALVO TEMP ERROR Z FPGA status bit 
HEAD 3.3V ERROR 
 

ADC leitura da cabeça ótica PCBA 3.3V  
 Nível fora da escala. 

HEAD 5V ERROR 
 

ADC leitura da cabeça ótica PCBA + 5V  
 nível  fora da escala. 



 
 

    
 

 

HEAD 12V ERROR ADC leitura da cabeça ótica PCBA + 12V/ -12  
 nível forada escala. 

HEAD 24V ERROR 
 

ADC leitura da cabeça ótica PCBA + 24V  
 Nível fora da escala. 

HEAD REF+ ERROR ADC leitura cabeça de referência positiva 
 Nível fora da escala. 

HEAD REF- ERROR 
 

ADC leitura da cabeça de referência negativa 
 nível fora da escala. 

HEAD TEMP ERROR ADC leitura da cabeça PCBA Temp 
 Nível fora da escala 

DET REF ERROR 
 

ADC leitura do detector SLC PCBA REF  
 Nível fora da escala 

DET SW[0:1] Ajuste da chave do detector analógico (2 bits) 
SLD TEMP ERROR 
 

Taxa da escala da temperatura ((> 30C) depois de 
filtrados 3 leituras. 
 

SLD CURRENT ERROR 
 

Escala da corrente SLD. 

SLD CAL PD ERROR 
 

Leitura do ADC do detector SLD o detector de energia 
calibrado fora da escala. 

X DAC ERROR 
 

Leitura de volta do ajuste inconsistente do X Galvo DAC  

Y DAC ERROR 
 

Leitura de volta do ajuste inconsistente do Y Galvo DAC 

Z DAC ERROR 
 

Leitura de volta Z DAC dos canais A, B, C ou D 
inconsistente. 

X GALVO ERROR 
 

X galvo posição da leitura de volta incorreta quando 
testado com 0V e 2V. 

Y GALVO ERROR 
 

Y galvo posição da leitura de volta incorreta quando 
testado com 0V e 2V. 

Z GALVO ERROR 
 

Z galvo posição da leitura de volta incorreta quando 
testado com 0V e 2V. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

    
 

 

 
 
 
 
 Declaramos verdadeiras as informações apresentadas neste Modelo de Instruções de Uso. 
 
 
 
 
 
 
_______________________ 
Eduardo Ricardo Rodrigues 
CREA-SP: 5062083030 
Responsável Técnico 
 
 
 
 
 
 
 
 
 
 
__________________ 
Roberto Zotter 
Responsável Legal 


